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ABSTRACT 
 

 

This report provides an analysis and evaluation of the “A STUDY OF PROJECT 
MANAGEMENT AND ITS PHASES, Project in general refers to a new endeavor with 

specific objective and varies so widely that it is very difficult to precisely define it. Some 

of the commonly quoted definitions are as follows. Project is a temporary endeavor 

undertaken to create a unique product or service or result. (AMERICAN National Standard 

ANSI/PMI99-001-2004) 

 

Purpose The purpose of this paper is to explore the extent of the continuing 

influence on project management (PM) research directions of rethinking project 

management over the last ten years. Design/methodology/approach The authors chose a 

qualitative research approach that involved reading all papers published in the International 

Journal of Managing Project in Business since its commencement in 2008. Content analysis 

was performed on these papers to allow axial coding of key article content influence 

themes. Findings the research identified the strength, over time, of the three research 

interest clusters on the PM research agenda and resultant changes in the PM paradigm. The 

five directions put forward by the rethinking PM agenda and other researchers ten years 

ago have continued to influence the PM research agenda. Originality/value Findings 

provide a better understanding the changes in PM research directions since rethinking PM, 

the increased breadth and sophistication of PM research in general, and future research 

directions. Project is a unique process, consist of a set of coordinated and controlled 

activities with start and finish dates, undertaken to achieve an objective confirming to 

specific requirements, including the constraints of time cost and resource. 

 
Project management is a distinct area of management that helps in handling 

projects. It has three key features to distinguish it from other forms of management and 

they include: a project manager, the project team and the project management system. The 

project management system comprises organization structure, information processing and 

decision- making and the procedures that facilitate integration of horizontal and vertical 

elements of the 
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CHAPTER 1 

INTRODUCTION 

 
Introduction 

Realization of these objectives requires systematic planning and careful 
implementation. To this effect, application of knowledge, skill, tools and techniques in the 

project environment, refers to project management. Project management in recent years 

has proliferated, reaching new heights of sophistication. It has emerged as a distinct area 

of management practices to meet the challenges of new economic environment, 

globalization process, rapid technological advancement, and quality concerns of the 

stakeholders. 

 

Project Definition 

Project in general refers to a new endeavor with specific objective and varies so widely that 

it is very difficult to precisely define it. Some of the commonly quoted definitions are as 

follows. Project is a temporary endeavor undertaken to create a unique product or service 

or result. (AMERICAN National Standard ANSI/PMI99-001-2004) 

 

Project is a unique process, consist of a set of coordinated and controlled activities 
with start and finish dates, undertaken to achieve an objective confirming to specific 

requirements, including the constraints of time cost and resource. 

(ISO10006) 

 

Examples of project include developing a watershed, creating irrigation facility, 

developing new variety of a crop, developing new breed of an animal, developing agro- 

processing center, Construction of farm building, sting of a concentrated feed plant etc. It 

may be noted that each of these projects differ in composition, type, scope, size and time. 

 

Project Characteristics 
Despite above diversities, projects share the following common characteristics. 

▪ Unique in nature. 

▪ Have definite objectives (goals) to achieve. 

▪ Requires set of resources. 

▪ Have a specific time frame for completion with a definite start and finish. 

▪ Involves risk and uncertainty. 

▪ Requires cross-functional teams and interdisciplinary approach. 
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Time Cost 

Project Performance Dimensions 

Three major dimensions that define the project performance are scope, time, and 

resource. These parameters are interrelated and interactive. The relationship generally 

represented as an equilateral triangle. The relationship is shown in figure 1. 
 

 
Scope 

 
Figure 1. Project performance dimensions 

 

It is evident that any change in any one of dimensions would affect the other. For 

example, if the scope is enlarged, project would require more time for completion and the 

cost would also go up. If time is reduced the scope and cost would also be required to be 

reduced. Similarly any change in cost would be reflected in scope and time. Successful 

completion of the project would require accomplishment of specified goals within 

scheduled time and budget. In recent years a fourth dimension, stakeholder satisfaction, is 

added to the project. However, the other school of management argues that this dimension 

is an inherent part of the scope of the project that defines the specifications to which the 

project is required to be implemented. Thus the performance of a project is measured by 

the degree to which these three parameters (scope, time and cost) are achieved. 

 

Mathematically 

Performance = f (Scope, Cost, Time) 

 
 

In management literature, this equilateral triangle is also referred as the “Quality 

triangle” of the project. 

 

Project Life Cycle 

Every project, from conception to completion, passes through various phases of a 

life cycle synonym to life cycle of living beings. There is no universal consensus on the 

number of phases in a project cycle. An understanding of the life cycle is important to 

successful completion of the project as it facilitates to understand the logical sequence of 

events in the continuum of progress from start to finish. Typical project consists of four 

phases- Conceptualization, Planning, 
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Execution and Termination. Each phase is marked by one or more deliverables such as 

Concept note, Feasibility report, Implementation Plan, HRD plan, Resource allocation 

plan, Evaluation report etc. 

 

Conceptualization Phase 

Conception phase, starting with the seed of an idea, it covers identification of the 

product / service, Pre-feasibility, Feasibility studies and Appraisal and Approval. The 

project idea is conceptualized with initial considerations of all possible alternatives for 

achieving the project objectives. As the idea becomes established a proposal is developed 

setting out rationale, method, estimated costs, benefits and other details for appraisal of the 

stakeholders. After reaching a broad consensus on the proposal the feasibility dimensions 

are analyzed in detail. 

 
Planning Phase 

In this phase the project structure is planned based on project appraisal and 

approvals. Detailed plans for activity, finance, and resources are developed and integrated 

to the quality parameters. In the process major tasks need to be performed in this phase are 

 Identification of activities and their sequencing 

 Time frame for execution 
 Estimation and budgeting 

 Staffing 

A Detailed Project Report (DPR) specifying various aspects of the project is 
finalized to facilitate execution in this phase. 

 

Execution Phase 

This phase of the project witnesses the concentrated activity where the plans are 

put into operation. Each activity is monitored, controlled and coordinated to achieve 

project objectives. Important activities in this phase are 

 Communicating with stakeholders 

 Reviewing progress 

 Monitoring cost and time 

 Controlling quality 

 Managing changes 
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Termination Phase 

This phase marks the completion of the project wherein the agreed deliverables are 

installed and project is put in to operation with arrangements for follow-up and evaluation. 

 

Life Cycle path 

The life cycle of a project from start to completion follows either an “S” shaped 

path or a “J “shaped path (Figure 2 and 3). In “S” shape path the progress is slow at the 

starting and terminal phase and is fast in the implementation phase. For example, 

implementation of watershed project. At the beginning detailed sectorial planning and 

coordination among various implementing agencies etc. makes progress slow and similarly 

towards termination, creating institutional arrangement for transfer and maintenance of 

assets to the stakeholders progresses slowly. 

Error! 

100  
Slow finish 

 

 

Quick 
Momentum 

 

 
Slow start 

 

Time 
Figure 2. Project life path –“S” shape 

 

 

In “J” type cycle path the progress in beginning is slow and as the time moves on 

the progress of the project improves at fast rate. Example, in a developing an energy 

plantation. In this the land preparation progresses slowly and as soon as the land and 

seedling are transplantation is under taken. This is shown in figure 3. 
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Figure 3. Project life cycle path - “J” Shape 

 

 

Project Classification 

There is no standard classification of the projects. However considering project goals, 
these can be classified into two broad groups, industrial and developmental. Each of these 

groups can be further classified considering nature of work (repetitive, non-repetitive), 

completion time (long term, shot term etc.), cost (large, small, etc.), level of risk (high, low, 

and no-risk), mode of operation (build, build-operate-transfer etc.). 

 

Industrial projects also referred as commercial projects, which are undertaken to 

provide goods or services for meeting the growing needs of the customers and providing 

attractive returns to the investors/stake holders. Following the background, these projects 

are further grouped into two categories i.e., demand based and resource / supply based. The 

demand based projects are designed to satisfy the customers’ felt as well the latent needs 

such as complex fertilizers, agro-processing infrastructure etc. The resource/ supply based 

projects are those which take advantage of the available resources like land, water, 

agricultural produce, raw material, minerals and even human resource. Projects triggered 

by successful R&D are also considered as supply based. Examples of resource based 

projects include food product units, metallurgical industries, oil refineries etc. Examples of 

projects based on human resource (skilled) availability include projects in IT sector, 

Clinical Research projects in bio services and others. 
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Development projects are undertaken to facilitate the promotion and acceleration of 

overall economic development. These projects act as catalysts for economic development 

providing a cascading effect. Development projects cover sectors like irrigation, 

agriculture, infrastructure health and education. 

 

The essential differences between Industrial projects and Developmental 

project aresumerised in the following table 1. 

 
Table 1. Difference between Industrial and Developmental Projects 

 

Dimension 
Industrial Project Developmental Project 

Scale of Project 
Limited Large 

Promoters 
Entrepreneurs or 

corporates 

Government, Public 

Sectors, 
NGOs 

Investment 
--- High 

Gestation Period 
--- High 

Profitability 
High, Considered on 

IRR ( 
Internal Rate of Return) 

Modest, Considered on 

ERR 
(Economic Rate of Return) 

Finance 
Stringent debt equity 

norms 

Operates on higher 

debt- 
equity norms 

Source of fund 
National stock markets 

and from domestic 

financial institutions 

International 

organizations like 

World 

Bank, 

IMF,ADB,DFID and 

others mostly as loan 

,yet times 
Providing for some grants. 

Interest rates and 
repayment period: 

Market rate and the 

repayment period is 

generally 7 to 10 years 

Very low for borrowed 

funds and the repayment 

period extends up to 25 

years and 

Even beyond. 

 
Project management 

Project management is a distinct area of management that helps in handling 

projects. It has three key features to distinguish it from other forms of management and 

they include: a project manager, the project team and the project management system. The 

project management system comprises organization structure, information processing and 

decision- making and the procedures that facilitate integration of horizontal and vertical 

elements of the 
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Project organization. The project management system focuses on integrated planning 

and control. 

 

Benefits of Project Management Approach 

The rationale for following project management approach is as follows. 

 Project management approach will help in handling complex, costly and 
risky assignments by providing interdisciplinary approach in handling the 

assignments. Example: R&D organizations. 

 Project management approaches help in handling assignments in a specified 

time frame with definite start and completion point’s .Example handling 

customer orders by Industries involved in production of capital goods. 

 Project management approaches provide task orientation to personnel in an 

Organization in handling assignments. Example: Organizations in IT sector 

handling software development assignments for clients. 
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CHAPTER 2 

LITERATURE REVIEW 
PROJECT IDENTIFICATION AND ITS FORMULATION 

 
A project in the economic sense directly or indirectly adds to the economy of the 

Nation. However an introspection of the project performance clearly indicates that the 

situation is far from satisfactory. Most of the major and critical projects in public sector 

that too in crucial sectors like irrigation, agriculture, and infrastructure are plagued by 

tremendous time and cost overruns. Even in the private sector the performance is not all 

that satisfactory as is evident from the growing sickness in industry and rapid increase in 

non-performing assets (NPAS) of Banks and Financial Institutions. The reasons for time 

and cost over runs are several and they can be broadly classified under-technical, financial, 

procedural and managerial. Most of these problems mainly stem from inadequate project 

formulation and haphazard implementation. 

 

Project Identification 

Project identification is an important step in project formulation. These are 

conceived with the objective of meeting the market demand, exploiting natural resources 

or creating wealth. The project ideas for developmental projects come mainly from the 

national planning process, whereas industrial projects usually stem from identification of 

commercial prospects and profit potential. 

As projects are a means to achieving certain objectives, there may be several 

alternative projects that will meet these objectives. It is important to indicate all the other 

alternatives considered with justification in favor of the specific project proposed for 

consideration. 

Sectorial studies, opportunity studies, support studies, project identification 
essentially focuses on screening the number of project ideas that come up based on 

information and data available and based on expert opinions and to come up with a limited 

number of project options which are promising. 

 

Project Formulation 

Project Formulation Concept 

“Project Formulation” is the processes of presenting a project idea in a form in 

which it can be subjected to comparative appraisals for the purpose of determining in 

definitive terms the priority that should be attached to a project 
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Under sever resource constraints. Project Formulation involves the following 

steps (Figure 1). 

 
PROJECT FORMULATION 

↓ 

OPPORTUNITY STUDIES/Support Studies 

↓ 

IDENTIFICATION OF PRODUCT/SERVICE 

↓ 

PREFEASIBILITY STUDY 

↓ 

FEASIBILITY STUDY 

(TECHNO ECONOMIC 

FEASIBILITY) 
↓ 

PROJECT APPRAISAL 

↓ 

DETAILED PROJECT REPORT 
 

Figure 1.  Project Formulation –Schematic view 

 
Opportunity Studies 

An opportunity study identifies investment opportunities and is normally 

undertaken at macro level by agencies involved in economic planning and development. 

In general opportunity studies there are three types of study – Area Study, sectorial and 

Sub-sectorial Studies and Resource Based Studies. Opportunity Studies and Support 

studies provide sound basis for project identification. 

 

 
Pre-feasibility Studies / Opportunity Studies 

A pre-feasibility study should be viewed as an intermediate stage between a project 

opportunity study and a detailed feasibility study, the difference being primarily the extent 
of details of the information obtained. It is the process of gathering facts and opinions 

pertaining to the project. This information is then vetted for the purpose of tentatively 

determining whether the project idea is worth pursuing furthering. Pre-feasibility study 

lays stress on assessing market potential, magnitude of investment, technical feasibility, 

financial analysis, risk analysis etc. The breadth and depth of pre-feasibility depend upon 

the time available and the confidence of the decision maker. Pre-feasibility studies help in 

preparing a project profile for presentation to various stakeholders including funding 

agencies to solicit their support to the project. It also throws light on aspects of the project 

that are critical in nature and necessitate further investigation through functional support 

studies. 
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Support studies are carried out before commissioning pre-feasibility or a feasibility 

study of projects requiring large-scale investments. These studies also form an integral part 

of the feasibility studies. They cover one or more critical aspects of project in detail. The 

contents of the Support Study vary depending on the nature of the study and the project 

contemplated. Since it relates to a vital aspect of the project the conclusions should be clear 

enough to give a direction to the subsequent stage of project preparation. 

 
Feasibility Study 

Feasibility Study forms the backbone of Project Formulation and presents a 

balanced picture incorporating all aspects of possible concern. The study investigates 

practicalities, ways of achieving objectives, strategy options, methodology, and predict 

likely outcome, risk and the consequences of each course of action. It becomes the 

foundation on which project definition and rationale will be based so that the quality is 

reflected in subsequent project activity. A well conducted study provides a sound base for 

decisions, clarifications of objectives, logical planning, minimal risk, and a successful cost 

effective project. Assessing feasibility of a proposal requires understanding of the STEEP 

factors. These are as under Social, Technological, Ecological, Economic, and Political. 

 
A feasibility study is not an end in itself but only a means to arrive at an investment 

decision. The preparation of a feasibility study report is often made difficulty by the 

number of alternatives (regarding the choice of technology, plant capacity, location, 

financing etc.) and assumptions on which the decisions are made. The project feasibility 

studies focus on 

- Economic and Market Analysis 

- Technical Analysis 

- Market Analysis 

- Financial Analysis 

- Economic Benefits 

- Project Risk and Uncertainty 

- Management Aspects 
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Economic and Market Analysis 

In the recent years the market analysis has undergone a paradigm shift. The demand 

forecast and projection of demand supply gap for products / services can no longer be based 

on extrapolation of past trends using statistical tools and techniques. One has to look at 

multiple parameters that influence the market. Demand projections are to be made keeping 

in view all possible developments. Review of the projects executed over the years suggests 

that many projects have failed not because of technological and financial problems but 

mainly because of the fact that the projects ignored customer requirements and market 

forces. 

 

In market analysis a number of factors need to be considered covering – product 

specifications, pricing, channels of distribution, trade practices, threat of substitutes, 

domestic and international competition, opportunities for exports etc. It should aim at 

providing analysis of future market scenario so that the decision on project investment can 

be taken in an objective manner keeping in view the market risk and uncertainty. 
 

Technical Analysis 

Technical analysis is based on the description of the product and specifications and 

also the requirements of quality standards. The analysis encompasses available alternative 

technologies, selection of the most appropriate technology in terms of optimum 

combination of project components, implications of the acquisition of technology, and 

contractual aspects of licensing. Special attention is given to technical dimensions such as 

in project selection. The technology chosen should also keep in view the requirements of 

raw materials and other inputs in terms of quality and should ensure that the cost of 

production would be competitive. In brief the technical analysis included the following 

aspects. 

Technology - Availability 

- Alternatives 

- Latest / state-of-art 
- Other implications 

Plant capacity -  Market demand 

- Technological parameters 

Inputs - Raw materials 

- Components 
- Power 
- Water 

- Fuel 

- Others 
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Availability skilled man power 
\Locatio 

n 

Logistic 

s 

Environmental consideration – pollution, etc., 

Requirement buildings/ foundation 

Other relevant details 

 

 
 

Environmental Impact Studies: 

All most all projects have some impact on environment. Current concern of 

environmental quality requires the environmental clearance for all projects. Therefore 

environ impact analysis needs to be undertaken before commencement of feasibility study. 

 

Objectives of Environmental Impact Studies: 

• To identify and describe the environmental resources/values (ER/vs.) or the 

environmental attributes (EA) which will be affected by the project (in a quantified 
manner as far as possible). 

• To describe, measure and assess the environmental effects that the proposed project 

will have on the ER/Vs. 

• To describe the alternatives to the proposed project which could accomplish the 
same results but with a different set of environmental effects 

The environmental impact studies would facilitate providing necessary remedial 

measures in terms of the equipment’s and facilities to be provided in the project to comply 

with the environmental regulation specifications. 

 

 
Financial Analysis 

 
The Financial Analysis, examines the viability of the project from financial or 

commercial considerations and indicates the return on the investments. Some of the 

commonly used techniques for financial analysis are as follows. 

 

 Pay-back period. 

 Return on Investment (ROI) 
 Net Present Value (NPV) 
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 Profitability Index(PI)/Benefit Cost Ratio 

 Internal Rate of Return (IRR) 

Pay-back Period 

This is the simplest of all methods and calculates the time required to recover the 

initial project investment out of the subsequent cash flow. It is computed by dividing the 

investment amount by the sum of the annual returns (income – expenditure) until it is equal 

to the capital cost. 

Example1. (Uniform annual return) 

A farmer has invested about Rest. 20000/- in constructing a fish pond and gets 

annual net return of Rs.5000/- (difference between annual income and expenditure). The 

payback period for the project is 4 years (20000/ 5000). 

Example 2. (Varying annual return) 

In a project Rs.1, 00,000/- an initial investment of establishing a horticultural orchard. 

The annual cash flow is as under. 

 

Time 
Annual 

Income 

Annual 

Expenditure 

Annual return Cumulative 

return 

1st Year 
60,000 30,000 30,000 30,000 

2nd Year 
70,000 30,000 40,000 70,000 

3rd Year 
85,000 25,000 60,000 1,30,000 

Pay-back period = Two and half years 

 
The drawback in this method is that it ignores any return received after the payback 

period and assumes equal value for the income and expenditure irrespective of the time. 

 

It is also possible that projects with high return on investments beyond the pay-back 

period may not get the deserved importance i.e., two projects having same pay-back period 

– one giving no return and the other providing large return after pay-back period will be 

treated equally, which is logically not correct. 
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Return on Investment (ROI); 

The ROI is the annual return as percentage of the initial investment and is 

computed by dividing the annual return with investment. It is calculation is simple when 

the return is uniform. For example the ROI of the fish ponds is (5000/ 10000) X 100 = 

50%. When the return is not uniform the average of annual returns over a period is used. 

For horticultural orchard average return is (1, 30,000/3) = 43333. ROI = (43333/100000) 

X 100 = 43.3 %. 

 
Computation of ROI also suffers from similar limitation as of pay-back period. It 

does not differentiate between two projects one yielding immediate return (lift irrigation 

project) and another project where return is received after some gestation period say about 

2-3 years (developing new variety of crop). 

 

Both the pay-back period and ROI are simple ones and more suited for quick 

analysis of the projects and sometimes provide inadequate measures of project viability. It 

is desirable to use these methods in conjunction with other discounted cash flow methods 

such as Net Present Value (NPV), Internal Rate of Return (IRR) and Benefit-Cost ratio. 

 
Discounted Cash Flow Analysis: 

 

The principle of discounting is the reverse of compounding and takes the value of 
money over time. To understand his let us take an example of compounding first. Assuming 

return of 10 

%, Rest 100 would grow to Rs110/- in the first year and Rest 121 in the second year. In a 

reverse statement, at a discount rate of 10% the return of Rs.110 in the next year is 

equivalent to Rs100 at present. In other words the present worth of next year’s return at a 

discount rate 10 % is only Rs.90.91 i.e., (100/110) Similarly Rs121 in the second year 

worth Rest 100/- at present or the present value of a return after two years is Rest. 82.64 

(100/121). These values Rs.90.91 and rs.82.64 are known as present value of future annual 

return of Rs.100 in first and second year respectively. Mathematically, the formula for 

computing present value (PV) of a cash flow “Can” in “nth” year at a discount rate of “d” 

is as follows; 

PV= Can / (1+d) n 

The computed discount factor tables are also available for ready reference. In the 

financial analysis the present value is computed for both investment and returns. The 

results are presented in three different measures i.e. NPV, B-C Ratio, and IRR. 
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Net Present Value (NPV) 

 

Net Present Value is considered as one of the important measure for deciding the 
financial viability of a project. The sum of discounted values of the stream of investments 

in different years of project implementation gives present value of the cost (say C). 

Similarly sum of discounted returns yields the present value of benefits (say B). The net 

present value (NPV) of the project is the difference between these two values (B- C). 

Higher the value of NPV is always desirable for a project. 

 
Benefit-Cost Ratio (B-C Ratio) or Profitability Index (PI); 

 

The B-C Ratio also referred as Profitability Index (PI), reflect the profitability of a 
project and computed as the ratio of total present value of the returns to the total present 

value of the investments (B/C). Higher the ratio better is the return. 

Internal Rate of Return (IRR): 

 

Internal Rate of Return (IRR) indicates the limit or the rate of discount at which 
the project total present value of return (B) equals to total present value of investments ( C 

) i.e. B-C 

= Zero. In other words it is the discount rate at which the NPV of the project is zero. The 

IRR is computed by iteration i.e. computing NPV at different discount rate till the value is 

nearly zero. It is desirable to have projects with higher IRR. 

 

 
Risk and Uncertainty 

 
Risk and Uncertainty are associated with every project. Risk is related to 

occurrence of adverse consequences and is quantifiable. It is analyzed through probability 

of occurrences. Whereas uncertainty refers to inherently unpredictable dimensions and is 

assessed through sensitivity analysis. It is therefore necessary to analyses these dimensions 

during formulation and appraisal phase of the programmer. Factors attributing to risk and 

uncertainties of a project are grouped under the following; 

 Technical –relates to project scope, change in technology, quality and quantity of 

inputs, activity times, estimation errors etc. 
 Economical- pertains to market, cost, competitive environment, change in policy, 

exchange rate etc. 
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 Socio-political- includes dimensions such as labor, stakeholders etc. 

 Environmental – factors could be level of pollution, environmental degradation etc. 

 

Economic Benefits: 

 

Apart from the financial benefits (in terms of Return on Investment) the 
economic benefits of the project are also analyzed in the feasibility study. The economic 

benefits include employment generation, economic development of the area where the 

project is located, foreign exchange savings in case of import substitutes or earning of 

foreign exchange in case of export oriented projects and others. 

 
Management Aspects: 

 

Management aspects are becoming very important in project feasibility studies. 
The management aspects cover the background of promoters, management philosophy, the 

organization set up and staffing for project implementation phase as well as operational 

phase, the aspects of decentralization and delegation, systems and procedures, the method 

of execution and finally the accountability. 

 
Time Frame for Project Implementation: 

 

The feasibility study also presents a broad time frame for project implementation. 
The time frame influences preoperative expenses and cost escalations which will impact 

the profitability and viability of the project. 

 

Feasibility Report: 

 

Based on the feasibility studies the Techno economic feasibility report or the 

project report is prepared to facilitate project evaluation and appraisal and investment 

decisions. 

 

Project Appraisal 

 

The project appraisal is the process of critical examination and analysis of the 

proposal in totality. The appraisal goes beyond the analysis presented in the feasibility 

report. At this stage, if required compilation of additional information and further 

analysis of project dimensions are 
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Undertaken. At the end of the process an appraisal note is prepared for facilitating 

decision on the project implementation. 

The appraisal process generally concentrates on the following aspects. 

• Market Appraisal: Focusing on demand projections, adequacy of 

marketing infrastructure and competence of the key marketing 
personnel. 

• Technical Appraisal: Covering product mix, Capacity, Process of manufacture 

engineering know-how and technical collaboration, Raw materials and 

consumables, Location and site, Building, Plant and equipment’s, Manpower 

requirements and Break- even point. 

• Environmental Appraisal: Impact on land use and micro-environment, 

commitment of natural resources, and Government policy. 

• Financial Appraisal: Capital, rate of return, specifications, contingencies, 

cost projection, capacity utilization, and financing pattern. 

• Economic Appraisal: Considered as a supportive appraisal it reviews economic 
rate of return, effective rate of protection and domestic resource cost. 

• Managerial Appraisal: Focuses on promoters, organization structure, 

managerial personnel, and HR management. 

• Social Cost Benefit Analysis (SCBA): Social Cost Benefit Analysis is a 

methodology for evaluating projects from the social point of view and focuses on 

social cost and benefits of a project. There often tend to differ from the costs 

incurred in monetary terms and benefits earned in monetary terms by the project 

SCBA may be based on UNIDO method or the Little-Mireles (L-M) approach. 

Under UNIDO method the net benefits of the project are considered in terms of 

economic (efficiency) prices also referred to as shadow prices. As per the L-M 

approach the outputs and inputs of a project are classified into (1) traded goods and 

services (2) None traded goods and services; and (3) Labor. All over the world 

including India currently the focus is on Economic Rate of Return (ERR) based on 

SCBA assume importance in project formulation and investment decisions. 

 
Detailed Project Report (DPR) 

Once the projects are appraised and the investment decisions are made a Detailed 

Project Report (DPR) is prepared. It provides all the relevant details including design 

drawings, specifications, detailed cost estimates etc. and this would act as a blue print for 

project implementation. 
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CHAPTER 3 

RESEARCH METHODOLOGY 

 
PROJECT MANAGEMENT PHASES 

 
Five Basic Phases of Project Management 

 

Project Management Institute, Inc. (PMI) defines project 

management as "the application of knowledge, skills, tools and 

techniques to a broad range of activities in order to meet the 

requirements of a particular project." The process of directing 

and controlling a project from start to finish may be further 

divided into five basic phases: 

 
 

Project initiation 

 

An idea for a project will be carefully examined to determine 

whether or not it benefits the organization. During this phase, a 

decision making team will identify if the project can realistically 

be completed. 

 

Project definition and planning 

 

A project plan, project charter and/or project scope may be put 

in writing, outlining the work to be performed. During this 

phase, a team should prioritize the project, calculate a budget 

and schedule, and determine what resources are needed. 

 

Project launch or execution 

 

Resources' tasks are distributed and teams are informed of 

responsibilities. This is a good time to bring up important 

project related information. 

 

Project performance and control 

 

Project managers will compare project status and progress to the 

actual plan, as resources perform the scheduled work. During 

this phase, project managers may need to adjust schedules or do 

what is necessary to keep the project on track. 
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Project close 
 

After project tasks are completed and the client has approved 

the outcome, an evaluation is necessary to highlight project 

success and/or learn from project history. 

Projects and project management processes vary from industry 
to industry; however, these are more traditional elements of a 

project. The overarching goal is typically to offer a product, 

change a process or to solve a problem in order to benefit the 

organization. 
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CHAPTER 4 

DATA ANALYSIS AND ITS INTERPRETATION  
 

 

Project management involves decision making for the planning, organizing, 
coordination, monitoring and control of a number of interrelated time bound activities. 

Project Manager therefore, often depends on tools and techniques that are effective enough 

not only for drawing- up the best possible initial plan but also capable of projecting 

instantaneously the impact of deviations so as to initiate necessary corrective measures.  

The search for an effective tool has resulted in development of a variety of techniques. 

These project management techniques can be classified under two broad categories i.e., 

Bar Charts and Networks. 

 
Bar Charts 

 

Bar charts are the pictorial representation of various tasks required to be performed 
for accomplishment of the project objectives. These charts have formed the basis of 

development of many other project management techniques. 

 

Gantt chart 

Henry L Gantt (1861 – 1919) around 1917 developed a system of bar charts for 

scheduling and reporting progress of a project. These charts latter were known as Gantt 

Charts. It is a pictorial representation specifying the start and finish time for various tasks 

to be performed in a project on a horizontal time-scale. Each project is broken down to 

physically identifiable and controllable units, called the Tasks. These tasks are indicated 

by means of a bar, preferably at equip-distance in the vertical axis and time is plotted in 

the horizontal axis (Figure 1). In this figure “Task A” is land preparation, “Task B” is 

procurement of inputs etc. Land preparation (Task A) takes five days starting from day 

one. However in practice the time scale is superimposed on a calendar i.e., if land 

preparation starts on 1st June it would be completed by 5th June. 

Length of the bar indicates required time for the task whereas the width has no 

significance. Though the bar chart is comprehensive, convenient, and very effective, it has 

the following limitations: 

 

 Like many other graphical techniques are often difficult to handle large number 

of tasks in other words a complex project. 
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 Does not indicate the inter relationship between the tasks i.e., if one activity 

overruns time what would be the impact on project completion. 

 

 

Task A 

 
 

Task B 

Task C 

Task D 
 
 

 

 
 

 

 

 
Milestone Chart 

Time (Days) 

Figure 1: Bar 

Chart 

Milestone chart is an improvement over the bar chart (Gantt chart) by introducing 

the concept of milestone. The milestone, represented by a circle over a task in the bar chart 

indicates completion of a specific phase of the task (Figure 2). For example land 

preparation (Task A) includes sloughing and leveling. From the simple bar chart it is 

difficult to monitor progress of the sloughing. Introduction of a milestone on day 3 would 

specify that the sloughing would be completed by day 3 of the project i.e. 3rd June. In a 

milestone chart a task is broken down in to specific phases (activities) and after 

accomplishment of each of the specific activity a milestone is reached or in other words an 

event occurs. The chart also shows the sequential relationship among the milestones or 

events within the same task but not the relationship among milestones contained in 

different tasks. For example in figure 2, the milestone 2 of task A cannot be reached until 

the milestone 1 is crossed and the activity between milestone 1 and 2 is over. Similarly, in 

task B the milestone 4 can begin only after completion of milestone 3. But the relationship 

between the milestone of task A and task B is not indicated in the milestone chart. Other 

weaknesses of this chart are as follows: 
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. ' '' 

 Does not show interdependence between tasks. 

 Does not indicate critical activities. 
 Does not consider the concept of uncertainty in accomplishing the task. 

 Very cumbersome to draw the chart for large projects. 
 

 

 

 

Task A 
 

 

Task B 

 

 

Task C 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Networks 
 

The network is a logical extension of Gantt’s milestone chart incorporating the 

modifications so as to illustrate interrelationship between and among all the milestones in 

an entire project. The two best-known techniques for network analysis are Programmed 

Evaluation and review Technique (PERT) and Critical Path Method (CPM). These two 

techniques were developed almost simultaneously during 1956-1958. PERT was 

developed for US navy for scheduling the research and development activities for Polaris 

missiles programmer. CPM was developed by E.I. du Pont de Nemours & Company as an 

application to construction project. Though these two methods were developed 

simultaneously they have striking similarity and the significant difference is that the time 

estimates for activities is assumed deterministic in CPM and probabilistic in PERT. There 

is also little distinction in terms of application of these concepts. PERT is used where 

emphasis is on scheduling and monitoring the project and CPM is used 

(Ploughing) (Land Leveling) 
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Figure 2: Milestone Chart 
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Land Preparation Procurement of input 

Where emphasis is on optimizing resource allocation. However, now-a-days the two 

techniques are used synonymously in network analysis and the differences are considered 

to be historical. 

Both CPM and PERT describe the work plan of project where arrows and circles 

respectively indicate the activities and events in the project. This arrow or network diagram 

includes all the activities and events that should be completed to reach the project 

objectives. The activities and events are laid in a planned sequence of their 

accomplishments. However, there are two types of notations used in the network diagram. 

They are as under, 

1. Activity-on-Arrow (AOA), and 
2. 2. Activity-on-Node (AON). 

In AOA notation, the arrow represents the work to be done and the circle represents 

an event – either the beginning 0f another activity or completion of previous one. This is 
shown in figure 3. 

Figure 3. Activity on Arrow 

For AON notation, a box (or node) is used to show the task it and the arrow 

simply show the sequence in which work is done. This is shown in figure 4. 
 

   

 

Land Preparation 

 

Procurement of input  

  

 
Figure 4. AON Diagram 

 
 

Most project management software usually uses AON diagram. AOA network 
diagram are usually associated with the PERT diagram. This would be used in the 

following sections. 

 

1.3.1 Programmed Evaluation and Review Technique (PERT) 

The PERT technique is a method of minimizing trouble spots, programmer bottlenecks, 

delays and interruptions by determining critical activities before they occur so that various 

activities in the project can be coordinated. 

 

PERT terminology 

Some of the terms frequently used in PERT are as follows. 

 

Activity: A recognizable work item of a project requiring time and resource for its completion. 
 

Dummy Activity: An activity that indicates precedence relationship and requires no time 

nor resource. 
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Critical Activity: Activities on the critical path having zero slack / float time. 
 

Critical Path: The longest time path connecting the critical activities in the project 
network. The total time on this path is the shortest duration of the project. 

 

Event: An instantaneous point in time signifying completion or beginning of an 

activity. Burst Event: An event which gives rise to more than one activity. 

Merge Event: The event which occurs only when more than one activity are accomplished. 

 

Expected Time: The weighted average of the estimated optimistic, most likely and 

pessimistic time duration of a project activity: 

 

To + 4 TM + T 

Expected Time (TE) = ------------------------ 

6 

 
Where T o is the Optimistic time, TM is the most likely 

time T is the Pessimistic time 

Earliest Start Time (EST): The earliest possible time at which the event can occur. The 
EST also denotes the Earliest Start Time (EST) of an activity as activities emanate 

from events. The EST of an activity is the time before which it cannot commence 

without affecting the immediate preceding activity. 

 

Latest Start Time (LST): The latest time at which the event can take place. Also referred 

as the Latest Start Time (LST) indicating the latest time at which an activity can begin 

without delaying the project completion time. 

Slack: The amount of spare time available between completion of an activity and 
beginning of next activity. 

 
 

Steps for Network Analysis 

The six steps of network analysis are as follows. 
 

1. Prepare the list of activities 

2. Define the inter relationship among the activities. 
3. Estimate the activity duration 

4. Assemble the activities in the form of a flow diagram 

5. Draw the network 

6. Analyze the network i.e. compute EST and LST; identify critical events, critical 

path and critical activities. 
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Step1: Prepare the list of activities 

An activity in a project is the lowest level of resource consuming, time-bound work 

having a specified beginning and endpoint. It should be quantifiable, measurable, 

constable, and discrete. The total project is subdivided into activities and each activity is 

given an alphabetical symbol / code. When the number of activities is more than 26, 

alphanumeric or multi -alphabet codes can be used. This involves a detailed delineation of 

the activities to be performed to complete the project. There is no limit to the number of 

activities to which the project should be splatted. However, it is advisable to limit the 

number to the minimum required from managerial consideration for avoiding unnecessary 

complexity. In a simple project it may be easier to identify the activity. In complex projects 

project activities are identified by splitting it into different hierarchical levels (sub- 

projects). For example in the activities of a watershed project could be broken down in to 

sub-projects such as agricultural sub-projects, Soil & water conservation sub-projects, 

Afforestation sub-project etc. For each of these subprojects the activities could be 

identified. Depending on the size and nature of the project sub-projects could be further 

divided into sub-sub project. 

For illustration of the process, a simple example of creating facility for lift irrigation 
in a farm would be used in the following text. Some of the assumptions are as under. 

1. It is assumed that the competent authority has approved the project and the 

project scheduling starts with the activity of “Site selection”. 

2. Irrigation would be provided from a newly dug well. 

3. Field channels from the well would be laid after its digging. 
4. Suitable pump would be procured and installed for lifting water. 

5. Specification for the pump is finalized based on the groundwater 

prospecting data before digging. 

6. Pump and other inputs would not be procured until the site is selected. 

7. Pump would be installed after digging the well. 

 
 

With above assumptions, the activities of the project are listed in Table 1. It may 

be noted the list is not exhaustive. The list would be different with different set of 

assumption or the perception of the project manager. More activities could be added to the 

list or some of the activities could be further subdivided. The number of activities in this 

example has been delineated and limited to only six numbers with objective of simplicity 

and to demonstrate the process of networking. 
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Table 1. List of activity 

 

Sr. No 
Activity Symbol / Code 

1. 
Site selection A 

2. 
Digging well B 

3. 
Laying field channels C 

4. 
Procurement of Pump D 

5. 
Installation of pump E 

6. 
Test run F 

 
Step 2:  Define the inter relationship among the activities 

The relationship among the activities could be defined by specifying the preceding 

and succeeding activity. Preceding activity for an activity is its immediate predecessor, 

i.e. the activity that needs to be completed before the start of the new activity. In the given 

example, selection of the site precedes digging of well. In other words the site needs to be 

selected before digging of the well. Thus the activity “Selection of site” becomes 

proceeding activity to the activity of “Digging the well” Succeeding activity is the one that 

immediately starts after completion of the activity. “Digging well” is the succeeding 

activity to “Selection of site”. 

In PERT the interrelationship is generally defined using the preceding activity. 

Only the terminating activities will not have any preceding activity. And all other activities 

must appear at least once as a preceding activity in the table. The inter relationship among 

the activities listed in the example is as in Table 2. 

 
Table 2. Interrelationship of activities 

 

Sr. No 
Activity Symbo 

l 

Preceding 

activity 

1. 
Site selection A ---- 

2. 
Digging well B A 

3. 
Laying field channels C B 

4. 
Procurement of Pump D A 

5. Installation of pump E B, D 

6. Test run F C, E 

 
Step 3: Estimation of activity time 

The activity time is the time, which is actually expected to be expended in carrying 
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out the activity. In deterministic cases as in CPM one time estimate is used. In probabilistic 

cases as 
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In PERT, the activity time has some kind of probabilistic distribution and is the weighted 

average of three time estimates (O p t i m i s t i c time, Pessimistic time and most likely 

time) for each activity. The expected time for each activity is computed as following: 

 
 

To + 4 TM + T 

Expected Time (TE) = ---------------------- 

-- 
6 

 

Where To be the Optimistic time, (minimum time assuming everything goes well) 

TM is the most likely time, (modal time required under normal 

circumstances) T is the Pessimistic time, and (maximum time 

assuming everything goes wrong) 

 

Example: Estimation of estimated time for the activity “Site selection” 

For this activity the tree time estimates i.e., Optimistic, Most likely and 

Pessimistic times are 4, 6 and 14 days respectively. 

 

I.e. TO = 4, TM = 6, and TP = 14. 
 

 

TE = 4 + 4*6 + 14  = 
4+24+14 = 42 = 7 days 

6 6  6 

 

 

 

Three time estimates, optimistic, pessimistic and most likely, could the decided on 
past experiences in execution of similar activities or from the feedback from individuals 

with relevance experience. The three time estimates and computed estimated time for the 

project activities are given in Table 3. 

 
 

Table 3. Activity time estimates 
 

 

S 

r 

. 

N 
o 

 

Activity 

 

Sym 

bol 

old 

 

Precedi 

ng g 

activity 

Time (Days) 

Opti 

mism 

tic 

Time 

TO 

Most 

likel 

y 

time 

TM 

Pessimi 

sm tic 

time TP 

Estim 

ate d 

time 

TE 

1. Site selection A ---- 4 6 14 7 

2. Digging well B A 2 3 4 3 

3. Laying field channels C B 7 16 19 15 
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4. Procurement of Pump D A 4 7 10 7 

5. 
Installation of pump E D, B 3 4 11 3 

 

6. 
Test run F C, E 1 2 3 2 

 

 

 

Network Diagram 

Having decided on activities, their relationship and duration (estimated time of the 

activity), next step is to draw the network diagram of the project. PERT network is a 

schematic model that depicts the sequential relationship among the activities that must be 

completed to accomplish the project. 

 

Step 4: Assemble the activities in the form of a flow chart. 

In a flow chart the activity and its duration is shown in a box. The boxes are 
connected with lines according to the preceding and succeeding activity relationship. The 

flow charts do not give details like start and completion time of each activity until unless 

it is super imposed on a calendar. It also does not facilitate computation of various slacks. 

However, the critical path for the project can be identified by comparing the various path 

lengths (sum of activity time, from start to finish, on any path). The longest path in the 

chart is the critical path. The flow diagram for the project considered for illustration is as 

in Figure 5. 
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Figure 5. The flow 
diagram Path I A-B-E-F 7+3+3+2 = 15 

A 7 

B D 

C E 3 

F 

FINISH 

START 
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Path II A-B-C-F    7+3+15+2 = 27 

Path III A-D-E-F 7 +7+3+2 = 19 

Path II i.e., A-B-C-F being the longest path (27 days) is the Critical 

path. Step 5: Draw the network 

This graphical representation of the project shows the precedence relationship 

among the activities. An arrow generally represents activities in the diagram while a circle 

represents event. Each activity starts with an event and end in an event. Activities in a 

project are performed either sequentially i.e. one after another or they are undertaken 

concurrently i.e. simultaneously. To draw the network it requires the knowledge of 

specifying which activities must be completed before other activities can be started, which 

activities can be performed in parallel, and which activities immediately succeed other 

activities. Some of the common combination of activity in a project is as follows, 

 

Sly 
No 

Diagram Logic 

1  

A 
 

 

 

 

B  

Activity “A” is preceding activity of “B”. 
I.e. activity ‘A” need to be completed before 

start of activity “B”. In other words “B” 

starts after 

“A” is finished. 

 
2 

  

A 
 

Activity “A” and “B” are concurrent. 

Activity “C” cannot start until both the 

activities “A” and “B” are completed. 
  C  

B  

3 
 

B  
 

Activity “B” and “C” are concurrent 

activities. Any one of these cannot start until 

activity “A” is completed. 

A  

 
C  

4 
  

Neither activity C nor D can start until both 

the activities A and B are completed. But C 

and D can start independently. 

5 
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  A    B  

Z 

D 

   A    B  

 
Z 

C D 
 

  

 

 

 

Activity D cannot begin until both A & C 
are completed. But B can start after A is 

complete. The activity Z, represented by 

dashed arrow, is a dummy activity 

(Explained below). It specifies the inter 

relationship. 

 

Dummy Activity: 

For example in a project Crop 2 is to be raised in same plot of land after 

harvesting of Crop 1. The activities and there inter relation could be as under 

 

Sly 
No 

Activity Code Preceding activity 

1 
Harvesting of Crop-1 A - 

2 
Sale of Crop – 1 B A 

3 
Raising nursery of Crop-2 C - 

4 
Transplanting Crop-2 D A, C 

 
The network diagram of the above project would be as follows 

 

The activity “Z”, represented by dashed arrow in the diagram, is a dummy activity. 
This does not consume any resource i.e. have zero time and zero cost. This only represents 

the logical relation among the activities. 

 
Rules for Drawing the Network: 

1. Each activity is represented by one and only one arrow in the network 

2. All the arrows must run from left to right. 

3. Dotted line arrows represent dummy activities. 

4. A circle represents an event. 

5. Every activity starts and ends with an event. 

6. No two activities can be identified by the same head and tail event. 
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7. Do not use dummy activity unless required to reflect the logic. 

8. Avoid Looping and crossing of activity arrows by repositioning. 

9. Every Activity, except the first and the last, must have at least one preceding and 

one succeeding activity. 

10. Danglers, isolated activities must be avoided. 

11. For coding use alphabets for all activities including the dummy activity and 

numbers for events. 

 

 

 

 

 

 
12. Standard representation of the event : 

 

 

 

 

 

 

 

 
The network diagram for the project detailed in Table 4 is as follows (Figure 6)... 

 

 

Figure 6. Activity inter-relationship 

 
Network analysis helps the manager to calculate the duration and identify critical 

activities in a project. Critical activities are those activities, which determine the overall 

duration of the project. The duration of the project is not necessarily the simple arithmetical 

sum of the individual activity durations because several activities occur concurrently in the 

project. Project duration would be equal to the sum of all individual activity durations only 

when all the activities in the project are sequential. The starting and finishing time for each 

individual activity is calculated through the network analysis. These computations provide 

a strong base for determining the work schedule. The network analysis includes the 

following. 

a. Event numbering 
b. Computation of the Earliest Start Time (EST) 

c. Computation of the Latest Start Time (LST) 

d. Computation of Earliest Finish Time (EFT) 
e. Computation of the Latest Finish Time (LFT) 
f. Identification of Critical Path 

g. Computation of Slack or Float 

EST 

Event 

Code 
LST 
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It is common practice to number every event in the network so that they are not 

duplicated, every event is identified with a reference number in the network and every 

activity is identified by its preceding and succeeding event numbers. There are two systems 

in vogue for numbering events: 

 

1. Random numbering system 

2. Sequential numbering system 

 
 

Random numbering system; In this system, events of a network are numbered randomly, 

thereby avoiding the difficulty in numbering extra events due to insertion of new jobs. 

Sequential numbering system: In this system the events are numbered successively from the 

beginning to the end of the network. For any individual job, the head (succeeding) event 

must bear a higher number than the tail (preceding) event. 

Fulkerson has reduced this sequential numbering to the following routine; 

1. Find the initial event and number it ‘1’ (An initial event is one which has arrows emerging 



35 
 

3 

B 
C 

F 

1 
A 

2      Z 
5 6 

D 
E 

4 

From it but none entering it). 

2. Now delete all the arrows emerging from the already numbered event(s). This will 
create at least one new initial event. 

3. Number all the new initial events ‘2’, ‘3’ and so on till the final event is reached 

(the final event is one which has no arrows emerging from it). 

 
The complete sequential numbering system described above is inconvenient when 

extra jobs have to be inserted. Extra jobs often mean extra events; when these events are 

numbered, all the events following them must be renumbered. One way to overcome this 

difficulty is to use tens only like 10 for the first event, 20 for the second event and so on. 

The event numbering of the network diagram for the project below (Table 1) is shown in 

figure 1. 

 

Table 1. Lift Irrigation in the farm. 

 

 
Sr. No 

 

Activity 
 

Symbol 
 

Preceding activity 
 

Time (Days) 

1. Site selection A ---- 7 

2. Digging well B A 3 

3. Laying field channels C B 15 

4. Procurement of Pump D A 7 

5. 
Installation of pump E D, B 3 

6. 
Test run F C, E 2 
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Step 6: Computing Earliest Start Time (EST) and Latest Start Time (LST) 

 
 

The EST represents the time before which the activity cannot begin and 

LST refers to the latest time by which the activity must begin. The EST and 

LST are computed in two phases. The EST is calculated first in the forward 

pass beginning from the start event. For the start event the EST is always set to 

zero so that it can be scaled to any convenient calendar date at a later stage. The 

EST at the last event is generally considered to be the project duration i.e. the 

minimum time required for project completion. Therefore, EST and LST are 

equal at the end event. LST for other events is then calculated through 

backward pass starting from the end event. Steps involved in computation are 

listed below. 

 

EST 
LST 

 

Through forward pass 
Through backward pass 

 

Calculation begins from start event 
Calculation stars from end event 

Proceeds from left to right 
Proceeds from right to left 

 

At start event EST is Zero 
At end event LST equals to EST 

 

Adding the activity time to EST 
Subtracting the activity time from LST 

 

At a merge event take maximum value 
At a burst event take minimum value 

 

Example: Computation of EST 

EST of an activity = EST of preceding activity + Activity duration 
EST at start event 1 (for activity A) is Zero. To compute EST at event number 2, add 7 i.e. 

the duration of activity A to zero. This is also the EST for both activities B and D starting 

from event 

2. Continuing, EST at event 3 is 10 i.e. (7+3). At event 4, being a merge event, will have 

two estimates of EST (considering Dummy activity Z and activity D). It is 10 (10+0) and 

14 (7+7). In cases where there is more than one estimate the maximum the estimates is 

considered. In this exercise maximum of 10 and 14 i.e. 14 is the EST at event 4. It is also 

EST of activity E. EST for the network is computed figure 2 a n d table2. 
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Figure 2. Computation of EST 

 

 
Example: Computation of LST 

LST of an activity = LST of succeeding activity – Activity duration 
Computation of LST starts from the end event of the project and proceeds backward. At 

the end event the LST is equal to the EST In this example at the event 6, the LST is equal 

to the EST and it is 27. At event 5, the LST is 27-2=25. Similarly at event 4 it is 25-3=22. 

Event 3 being a burst event (i.e. more than one activity emanating from this event) will 

have two estimates of LST and in such cases only the minimum value of the LST is 

considered. Accordingly at event 3, the two estimates are 22-0=22 and 25-15=10. 

Minimum of these two values 10 is the LST at event 3. Similarly at event 2 it is the 

minimum of 10-3=7 and 22-7=15 i.e. 7. Accordingly at event 1, LST is 7-7=0 which is 

equal to the EST at the start event. Both the EST and LST values for the project activities 

are presented in figure 3. And table 2. 

 

Table 2. The EST and LST of activities 

 

Event 
No. 

EST  Event 

No. 

LST 

1 
0 

6 
27 

2 
0+7 = 7 

5 
27-2 = 25 

3 
7+3 = 10 

4 
25-3= 22 

4 
Max. (7+7=14, 10+0=10) = 10 

3 
Min.(25-15=10,25-0=25) =10 

EST 10 

3 

B 
C 

1 

0 A 7 
3 

2 

1 2 Z 5 

7 
0 

F 

2 
6 

2 

D 

7 
14 

E 

3 

4 
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Figure 3. The EST and LST of activities 

 
 

Computation of the Earliest Finish Time (EFT) and the Latest Finish Time (LFT) 

The EFT for each activity is calculated starting from the first activity, which 

commences after the start event. It is given by 

 

EFT of an activity + EST of preceding activity + activity duration. 

 
 

The calculation of LFT starts from the last activity of the network or from the computed LST and is given by, 

LFT = Latest Starting Time (LST) of succeeding event 

The various computed for the project is given in table 3. 
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Table 3. Computed times for the activities 

 

Sly No 
Activity Duration EST LST EFT LFT 

1 
A 7 0 0 7 7 

2 
B 3 7 7 10 10 

3 C 15 10 10 25 25 

4 
D 7 7 15 14 22 

5 
E 3 14 22 17 25 

6 
F 2 25 25 27 27 

 

 

 
 

Calculation of Slacks / Floats 

Slack or float is used to indicate the spare time available with in a non-critical activity. 

However, in general slack relates to an event and floats to an activity. These are important 

for smoothening the resource utilization in a project. The various floats and slacks are 

computed as follows 

a. Event Slack = LST-EST 

b. Total Flat is the time available for an activity over and above the requirement 

for its completion. 

Total Float = LST of end event – EST of Starting event- Duration of reference activity 

c.  Free Float is the time available for an activity to expand without influencing 

the later activities. 

Free Float = EST of end event – EST of starting event – Duration of reference activity. 

d.  Independent Float is the time with which an activity can expand without 

influencing the preceding or succeeding activities. Seldom could the independent 

float be negative. In such cases it would be considered to be equal to zero. 

Independent float = EST of end event – LST of starting event – Duration of 

reference activity. 

 

 
Floats and their relation ship 

Various floats and their relationship is shown in Figure 3. It may be observed 

that Total Float is more than or equal to free float. And free float is more than 

or equal to 

Independent float. I.e. TF>= FF >= IF 
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Figure 4. Relationship between the floats 

 

 
Identification of Critical Events 

The critical events of the project are identified by the event slack i.e. the difference 

between LST and EST. For critical events this slack is zero i.e. the value of LST and EST 

are equal. The event slack computed for all the events of the project are as follows Table 

4: 

Table 4. Event Slacks 

 

Event No LST EST Event slack Critical / NC 

1 
0 0 0 Critical 

2 
7 7 0 Critical 

3 10 10 0 Critical 

4 
14 22 8 Not Critical 

5 
25 25 0 Critical 

6 
27 27 0 Critical 

 
With above values of EST, LST and event slack the Critical Events are 1,23,5, and 6. 
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Identification of Critical Activity 

An activity can be called as critical activity if the following conditions are satisfied. 
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i. LST and EST are equal at the head event 

ii. LST and EST are equal at tail event 

iii. Difference between EST at head and tail event of the activity equals 

to the activity time. 

iv. Difference between LST at head and tail event of the activity equals 

to the activity time. 

 
Review of computation results suggests that the critical activities in the project are 

A, B, C, and F. 

 

 
Identification of Critical Path 

The critical path is the chain of critical activity spanning the network from start to 

end i.e. the path joining all the critical events. It is also the longest path from start to end 

of the project network. Alternatively therefore comparing all the possible path lengths can 

identify the critical path (see flow diagram). The critical path time is the shortest duration 

of the project. The critical path is denoted preferably by denoting the critical events on the 

path. 

 

Critical path for the project is, A – B –C – F. 

 
 

The critical path of the project can also be denoted in terms of the event numbers. 

In the present project it is 1- 2–3 – 5-6. To distinguish the critical path from other paths in 

the project, it is preferable to use a thicker line to demarcate the critical path. It is quite 

possible that a project can have multiple critical paths. In such case the length of all the 

critical paths will be equal. 

 

Critical Path and Project Management: 

The critical path time being the shortest project time any delay in completion of any 

of the activity on the critical path would delay the entire project. Therefore it is the critical 

activity that needs to be monitored for timely completion of the project. However, the 

activities with positive event slack could be rescheduled within the available time frame 

for efficient utilization 

I.e. smoothing of the demand on the available resources. If the duration of the project 

requires to be reduced, activities on the critical path will be the ones to be considered for 

completion at an early date with allocation of additional resources. 
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Network Revision 

So far the steps involved in developing the initial network provided two basic pieces 

of information an estimate of the project duration and the critical path. 

The initial network constructed is examined to convert it into a valid, practical 

network which satisfies the project requirements and provides the basis for effective 

implementation and control. This process is called network revision. 

The purpose of revision is two-fold. Firstly, it is concerned with improving the 
quality of the information in the network; information about the relationships and durations 

of activities. Secondly, it is concerned with ensuring that the final network satisfied the 

project objectives. These relate to four factors; time, cost, resources and performance. 

 

Reviewing the relationships: The first task is to review the activities and their relationships. 

Some relationships may not have been shown properly in the initial network. A sequence 

of activities which at first sight appear to need serial representation, can sometimes be 

arranged to take place in parallel with one another. Often it is s only a part of an activity 

which really conditions the start of the following activity, and in these cases, the activity 

can be subdivided and part of it depicted on the network as occurring in parallel with other 

activities. If the activity thus treated is on the critical path, a useful shortening of the project 

duration can be achieved. 

 
Reviewing the duration of activities: At the revision stage, the activity durations must be re- 

examined in the light of information about the project duration and critical path. Work may 

have to be analyzed in greater detail, suppliers may have to be contacted for confirmation 

of current delivery periods and so on. Less accurate estimates can usually be tolerated for 

activities with plenty of float. 

For some activities, the duration is variable. The time required to carry out the work 

depends almost entirely upon the quality or accuracy of performance specified. Estimates 

for research and development work and producing advertising copy or design work may 

be of this type. One approach for reviewing the duration of the activities when they are 

not critical is the use of the concept of available time. 

One useful little check, which can be applied to the activity durations, is to calculate 

the parentage of even number durations in the network. Because of a fairly general bias 

towards even numbers, the percentage is rarely as low as the theoretical 50%. 

 

Project objectives while in theory, the objectives of every project should be clearly defined at 

the outset, and in practice this is not always done. On the other hand, the initial network 

assists and 
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Forces the clear definition of project objectives. Statement about objectives is usually 

expressed in term of time, cost, resources and performance. It will be realized that the 

objectives stated in terms of one factor may conflict with others. For example, it may not 

be possible to complete a project in the shortest time and at minimum cost. If a network is 

to be checked to see whether it satisfies the project objectives, then these objectives must 

have been stated in such a way as to recognize and assign priority to their relationships. 

 
Meeting time objectives; it is likely that the project duration calculated from the initial 

network may not be acceptable to the management. This means that at the revision stage, 

the network must be modified to satisfy any time limits set for the project. If the project 

duration is to be reduced, the critical activities must be subjected first to careful 

examination. Changes in the relationships in turn affect the time along the concerned path 

as discussed earlier. 

But once the possibilities for changes in relationships have been exhausted, the 

scope for reduction in the duration of critical activities must be examined. In some cases, 

this may mean diverting resources from non-critical activities to critical, ones. In others, 

this may mean the use of more labor, more machines; overtime work or extra shifts. 

 

Meeting cost objectives: The cost of a project is usually given in terms of an estimate which 
may be required for such purposes as establishing feasibility, finding out return on 

investment, obtaining approval or getting out a price for a job, etc. The time involved will 

be important and a realistic cost target cannot be set without a careful study of the plan 

embodied in the network. The plan will determine in broad terms the pattern of expenditure 

over the period of the project. The network can be used to investigate this pattern of 

expenditure and the results can be compared with the availability of money. The network 

may indicate a pattern of expenditure in excess of what is possible, in which case the plan 

will have to be modified. 

Certain activities can be speeded up or slowed down depending upon the amount 

of money spent on them. The network can be used to examine the relationship between 

total time and total cost, and the project duration established for which the total cost is 

minimum. These aspects will be discussed in more detail later. 

 

Meeting resource objectives: The initial network is drawn without considering the resources 

as this does not affect the relationships between activities. However, if the resources are 

limited, the plan must be examined to see to what extent it will have to be modified in the 

light of resource availability. Activities which are independent may have to be made 

dependent upon one another because they will be done by the same machine or by the 

same man. For example, a 
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Number of fitting jobs may be unrelated in the network, but if there is only one fitter to 

whom this work can be allocated then the jobs will have to be done one after the other. If 

the jobs have sufficient float to allow this, the project completion date will remain 

unaffected; but if the float is inadequate, an additional fitter has to be employed or a later 

completion date accepted. The plan. Should be modified accordingly. 

Another aspect which should be considered at this stage is the relationship between 

to duration of an activity and the resources allotted to it. The original duration assumes 

normal resources but for some activities, this time may be varied by altering resources put 

on the job. Thus certain critical activities may be speeded up by putting on additional 

resources, while activities with plenty of float may be allowed to take longer time with less 

resources, thus releasing men for more critical activities. 

Examination of the network can throw some light on the resource implications of 
the plan in a general way. Often a detailed analysis of the network is necessary, if the 

information is going to lead to management action. The analysis of network with respect 

to resources will be discussed in detail later. 

Activity Scheduling 

Once the final network is drawn the next step is to convert this into a programmer 

of work. This step is known as Scheduling. 

Critical activities, by definition have only one possible starting time if the project 

completion date is to be met. All other activities in the network have a range of possible 

start times from the earliest to the latest start time. The actual starting times of activities 

are decided based upon any one of the following approaches; 

 
All activities started 

1. at earliest start times 

2. at latest start at times 
3. by distributing float 

1. at arbitrary start times 

2. by considering resource availability 

 
 

All activities started at earliest start time 

In order to minimize the effect of delays on the project completion date due to 

unforeseen delays in some activities, it is desirable to preserve the float for later use. One 

way of ensuring this is to start all activities at their earliest start times. 

The schedule start time can be read straight from the network without further 

computation. This approach, though simple has its disadvantages. Using the network as a 

rigid schedule to start activities as early as possible may result in unnecessary increase in 

costs. Expensive plant and equipment delivered at the earliest possible time may be lying 

idle awaiting installation, or staff may be recruited well before there is any work for them. 

From the angle of finance, money should be spent as late as possible; this means carrying 

out activities as late as possible. 

 
All activities started at latest start times 

From the financial point of view this approach is far better and might result in 

significant saving of money. But the disadvantages are so obvious, schedulers dare not use 
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this approach. Starting all activities at their latest start times will mean deliberately 

discarding available float with the result that all activities, in the project become critical. 

The project becomes extremely sensitive to delays and its chance of being completed on 

time is very remote. 
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All activities started by distributing float 

As a compromise between the two above mentioned extremes, via, starting all 

activities at earliest start times and starting all activities at latest start times, it is possib1e 

to distribute the total float which exists in a chain of activities in such a way that, each 

individual activity is allocated a portion of it. This approach is based on the assumption 

that since most activity times will vary, from the original estimate, it is advisable to allow 

for some variation in as many activities as possible. 

The main objection to this method is that it allows float to be given up and used as 

a contingency allowance, and that if a major delay occurs one may find that the float given 

away earlier is now desperately needed. There is always a danger that once float is allocated 

to an activity, it will be used up, whether it is really required or not in accordance with the 

famous Parkinson’s Law which states that ‘work expands to fill the time available for its 

completion’. 

 
All activities started at arbitrary start times 

One way out of this dilemma is to leave the decision about the actual start time to 

the person responsible for the execution of the activity, pointing out that it must be started 

between earliest start time and latest start time. This approach is usually unsatisfactory and 

leads to lot of confusion as the project proceeds, as no one can be really sure when activities 

carried out by others are going to finish, and hence they cannot easily plan their own work. 

This approach also has the disadvantage of distributed float method as for one reason or 

the other the float would have been gradually used up leaving all the remaining activities 

critical. 

 
All activities started by considering resource availability 

Resource availability is one factor which may have an important influence on when 

activities can actually be started. The initial network ignores this factor, and it is at the 

scheduling stage that the resources have to be taken into account. Activities which could 

logically be carried out in parallel may have to be done in series and this phasing of 

activities to meet resource limitations will involve the use of float. The planning of work 

to balance such requirement against availability may be an overriding factor in deriving 

schedules and these aspects are discussed in detail later. 

In practice no approach other than that of resource considerations, can be used to 

determine the start times of all activities in the project. 

 

Resource Analysis and schedu1ing 

In some projects, time is all-important and considerations of cost and resources are 
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Secondary. Examples of this type are research and development projects. But for most 

projects, resources are always limited and hence the success of the projects depends on the 

ability to use the available resources effectively. This calls for a careful analysis of the 

network to see how far the requirements can be met, what changes may be needed to the 

plan and how efficiently the resources can be used. A network is primarily designed to give 

information about time, but can be used to study resources as well, as discussed below: 

 
 

Resource analysis: By associating with each activity in the network, the units of resources 

that would normally be used to carry it out, it is possible to analyses the total resources 

requirement against time over the duration of the project. From a schedule where all 

activities start at their earliest start times, a resource histogram can be constructed, showing 

the total units of resources required for each unit of time through the project. This 

procedure is called resource analysis. If the units of available resources are known, the 

histogram can be used to investigate whether the schedule creates less/same/more demands 

on resources. The procedure is illustrated in the following example. 

 

Project: Establishment of a Mango orchard 
 

 

Activity 
Symbol Preceding Duration (Day) Manpower/day 

Land preparation 
A - 3 4 

Digging pits 
B A 5 4 

Purchase saplings C A 3 2 

Application of FYM D B 3 3 

Transplant saplings E C,D 4 4 

 

The network diagram for the project is given in figure 4. 
 

 
 

4. M of 
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In the above diagram the critical path is A-B-D-E and the project duration is 15 
days. The Total float of the activity C is 5 days. Assuming the activities are scheduled on 

the Earliest Start Time (EST) the manpower requirement for the project is shown in figure 

5. 
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Figure 5: Pattern of manpower requirement 

 

From the above figure it is evident that the manpower requirement is to the 

maximum of 7 numbers during 3rd to 6th day of project commencement and the minimum 

requirement is 3 persons during 8th and 11th day. The difference is 4 persons. 

 

Considering the float of the activity C, this activity can be scheduled for any three 
days between 3rd to 11th days. If it is scheduled during 9th to 11th day the manpower 

requirement pattern would be as in figure. The demand is almost uniform, the 

difference between the 
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Maximum and the minimum is only one person. The manpower demand for the project 

duration after rescheduling the activity C is shown in figure 6. 
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Figure 6. Revised schedule of activities. 

 
 

The resource smoothing is a technique applied to distribute the resources load 

evenly throughout the project period. In agricultural projects where the field operations are 

highly dependent on weather, cropping pattern, crop characteristics, application of this 

technique would be limited to the use of implements or to the operation those are not bound 

by natural phenomena. 
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Project Crashing and Project Control 

 
 

Time-Cost Relationship of an Activity 

The time required for the performance of an activity is estimated according to the 

quantity of resources. Except for fixed duration activities such as crop duration, gestation 

period etc. it is possible to manage the duration of an activity by varying the quantity of 

resource. If cost is not a constraint, putting more resources to the activity duration could 

reduce be reduced. This in other word means time and cost of a project are inversely related. 

The relationship between cost of an activity and its duration may take the form of the curve 

as depicted in figure 1. 
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For the activity is called crash time. The costs associated with these times are called 

respectively the normal cost and the crash cost. Although it is possible to estimate the time 

and cost associated with the normal and crash conditions for each activity it is difficult to 

estimate the time and cost at any intermediate stage between these two points. To 

overcome this difficulty, it is assumed that the relationship between the time and cost as 

linear in the range between normal and crash situations. 

 
Project Crashing 

Project crashing is an exercise carried out to reduce the time of a project by 

investing more money. This becomes necessary when the dead line has to be met. For 

crashing only the critical are considered since duration of the project could be reduced by 

crashing these activities only. It is possible that when a project is crashed another non- 

critical activity may become critical and in the next cycle this has to be considered for 

further crashing. The steps involved in 

 

 

 
T 
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Crashing are as under. 

a. Identify critical path and critical activity 
b. Compute crash cost slope i.e. (Crash cost – Normal cost) / (Normal Time – 

Crash Time) 

c. Select the activity with the least cost slope i.e. minimum crash cost per time. 

d. Check for the critical path. 

As the project shortening (crashing) continues, a point is reached at which no further 

crashing is possible. At this point, some activities might not have reached their crash 

points. If these activities are crashed further, costs are increased with no saving in project 

duration. 
 

Project Crashing Example 

The principles of project crashing are illustrated with the help of the example. Activity 
table of the project and the network diagram are shown in Table1 and Figure 1 

respectively. Table 2 presents the normal and crash parameters. 

 

Project: Development of Agro-Technology Demonstration 

Blocks Table 1. Activity Table 

Sly 

No 

Activity Symbol Preceding 

activity 

Duration 

(Weeks) 

1 
Leveling the land A - 16 

2 
Stone pitching B A 26 

3 
Raising seedling C A 26 

4 
Establishment of irrigation 

system 

D A 30 

5 
Development of drainage 

system 

E C 28 

6 
Making pits and 
transplantation 

F B 27 

7 
Erection of fencing G D,E,F 18 

3 

B 
26 

27 
F 

1 

A 

16 
2 

D 

30 
5 

G 

18 
6 

26 
C E 

28 

4 
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Table 2. Normal and Crash parameters 

 

Activity 
Time in weeks Cost in Rest. Reduction 

in time 

Increase 

in cost 

Cost slope 

(Rest./wee 

k) Normal 
Crash Normal Cost 

A 
16 11 36000 38000 5 2000 400 

B 
26 18 27000 33000 8 6000 750 

C 
26 21 8000 8900 5 900 180 

D 
30 23 135000 138570 7 3570 510 

E 
28 20 20000 22400 8 2400 300 

F 
27 23 12000 13700 4 1700 425 

G 
18 12 35000 36500 6 1500 2500 

Total 
273000 291070 43 18070  

 
The above project has a duration (Critical path length) of 88 weeks, normal cost 

Rs273000 and crash cost of Rest. 291070. For crashing, the critical activities in the 

project A, C, E and G are to be considered first. Activity C has the least cost slope i.e. 

Rs180/ week and can be crashed first from 26 to 21 weeks. After this crashing the project 

duration is reduced to 83 weeks (Activity C from 26 to 21 weeks) and the cost has 

increased from Rs.2, 73,000 to Rs.2, 73,900. 

The revised PERT network of the project after crashing is as in figure 2. 

 

 

Figure 2. The network diagram after crashing activity C 
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In the redrawn network the new critical path is A, B, F and G. These activities 

are to be considered for further crashing. Among these activity G having least cost can be 

crashed from 18 
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Weeks to 12. The project cost would be increased from 2, 73900 to Rest 275000. After 

crashing the network diagram is to be drawn and the procedures could continue till a stage 

is reached when no further crashing is possible. The crashing result for the project is 

summarized in Table 3. 

 

Table 3. Summary of crashing exercise 
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Crashe 

d d 

Time 

(Wee 

k 

s) 
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Cumulate 
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Reductio 

n 

Before 

crashin 

g g 

After 

crashin 

g g 

Cumulat 

e vet 

increase 

Normal 
  88 - - 273000 - - 

C 
5 5 88 87 1 273000 273900 900 

G 
6 6 87 81 7 273900 275400 2400 

A 
5 5 81 76 12 275400 277400 4400 

F 
4 4 76 72 16 277400 279100 6100 

E 
8 8 72 72 16 279100 281500 8500 

B 
8 8 72 64 24 281500 287500 14500 

 
It may be noted from the above table that even though the activity C is crashed by 

5 weeks i.e. from 26 to 21 weeks, the critical path length has not reduced to the same extent. 

It has reduced by only one week i.e. from 88 to 87 weeks. This in other words the crashing 

of 5 weeks in the activity C has resulted only one week reduction in the project time. This 

happen only when the difference between the critical path and the other paths are less than 

the crashed period (In the example Critical path was 88 weeks and the next path length 

was 87. This difference of one week which is less than the crashed period of 5 weeks). 

Cases where the network has two or more critical paths crashing one activity may not result 

in any reduction of project duration as in case of crashing activity. For example after 

crashing activity of the project will have two critical paths i.e. A-B-F-G and A-C-E-G. 

Further crashing of activity E would not result in reduction of project duration. Because 

the path A-B-F-G would still remain as critical path. The project in example could be 

crashed to the maximum of 24 weeks by incurring additional expenditure of Rs.14500. 

 
Crashing of project indicates the time-cost trade-off implication. The decision on 

the extent to which the project is to be crashed depends on the managerial decision based 

on paucity / availability of fund. 



56 
 

Project    Control 

Steps in Project Control 

Fixing up the Review Period Obtaining 

Progress Information 

Comparing Actual Progress with the Schedule Taking 

Appropriate Corrective Correction 

Reporting to Higher Management Updating 
Conventions for Updating Frequency 

of Updating 

 
Redrawing Network 

 
So far the discussions were on the use of PERT/CPM in planning and 

scheduling a project. This unit considers the third aspect, viz. the use of this method 

during project execution. No management technique, however elegant and 

sophisticated, can take away the responsibility of management to exercise control 

through making decisions. 
Manageme 

nt techniques will, however, by providing the relevant information, enable 

management to take better-informed decisions and thereby exercise a finer degree of 

control than would be possible 

Otherwise. 

A project being a dynamic entity must respond to changing conditions if it is to be 

completed successfully. Further projects are always executed in an environment of endless 

change, and there is therefore the need for continuous reassessment and reappraisal of the 

project. The original plan and schedule cannot therefore be executed to the last detail 

because of a host of influencing factors, of which the following are a few. 

 Changes in the date for completion 

 Changes in activity durations 

 Changes in resource availability 

 Changes in activity relationship 

 Failure of suppliers to deliver on time 

 Unexpected environmental conditions (strikes, weather, etc.) 

It is, therefore, necessary to have some procedure whereby the progress of 

work is checked at regular intervals against the plan, discrepancies highlighted and 

the necessary 
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Corrective active action taken to ensure that objectives are achieved. This is the function 

of project control. 

Measurement of the actual achievement and comparison with the original plan is 

therefore an essential feature of an effective control system. The sequence of instruction, 

execution, measurement, feedback and. correction is fundamental to control theory. 

The management of the project is therefore a continuous process involving both 

planning and control. While the planning can be done at leisure, the control phase is carried 

out under continuous pressure. 

The continuous recycling of information helps comparing with the original. Plan 
and in cases of deviation (in majority of the cases deviations do, occur as it is very rare that 

plan targets are fulfilled exactly) it becomes necessary to reschedule the plan. This involves 

considerable work even in smaller projects. In the case of large projects involving several 

activities, a computer becomes an invaluable tool. 

Project control in action: The steps involved in project control are: 

1. Fixing up the review period 

2. Obtaining progress information 
3. Comparing actual progress with the schedule 

4. Taking appropriate corrective action when required. 

 
 

Fixing up the review period: How often the project is to be reviewed depends upon a large 

number of factors and there can be no standard rule or practice about this. The frequency 

of reviewing however will depend upon the type of project, its overall duration and the 

degree of uncertainty involved. 

For the average project, a fortnightly review should be sufficient in the normal 
course but in the case of rapidly changing projects, higher frequency of reviewing is 

necessary to have close control. Projects of the same overall duration using 3 time estimates 

(PERT system) for activities require greater frequency of reviewing than those using single 

time estimates (CPM system) for activities. The interval between reviews may change 

depending on the management needs. 

 

Obtaining progress information: For obtaining progress, a form shown below is normally 

used. The basic information required refers to activities just started, activities completed, 

and progress on current activities. While the information regarding first two can be given 

precisely, the last may best be quantified by estimating the comp1etion date. 
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Progress Report 

 

Project 
For delayed activity 

Activity 
Duration Scheduled date Actual date Expected date Remarks 

  Start Finish Start Finish Start Finish 

         

 
Comparing actual progress with the schedule: The actual progress is transferred either on to 
the network or to the scheduling table so that it can be compared with the schedule to 

identify deviations. 

Taking appropriate corrective action when required: Obtaining progress information and 

identification of deviations alone are of little value without effective follow up. If a delay 

occurs in a non-critical activity, corrective action will usually be limited to rescheduling 

the following activities. If a delay occurs in one of the critical activities, corrective action 

would include adding additional resources from non-critical to critical jobs, rescheduling 

of series operations in parallel etc. If the time cannot be made up by any of these methods, 

completion of the project will be delayed. 

Based on the corrective action taken, fresh schedules are prepared for the following 

week/fortnight and the control cycle consisting of execution, measurement, feedback 

correction and instruction repeats itself. 

Frequency of updating: There is no standard practice regarding the frequency of updating. 

Updating may be undertaken at regular intervals or whenever the situation warrants it. 

Updating should be done whenever major changes occur that will affect project completion 

date or cause a shift in the critical path, or when the impact of changes on the schedule 

cannot be readily noticed by inspecting the network. 
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CHAPTER 5 

DISCUSION, EXAMPLES AND FINDING 

Overview of Microsoft Project 
 

Start MS Project 

 

 

 

 

 
Using Help 

 

 Double-click on the MS Project icon. 

Or 
 

 Click the Start button, select Programs, and select the Project icon. 

 
 Click on the Help menu and select Microsoft Project Help or press 

[F1]. 
 

 The Project Help task pane will open on the right of the screen 
enabling you to search for assistance on a specific topic. 

 

 

The Office Assistant 

The office assistant offers tips on what you are doing, can answer questions you have, 

and enables you to ask questions in a non-jargon way. The office assistant usually 

appears as an animated paper clip. 

 
To Use the Office Assistant 

 
 Click on the Help menu and select Show the Office Assistant

 Type in the topic required.

 Click on Search

 

Note: When performing certain actions (especially for the first time) the Office 

Assistant will appear automatically with a list of help options relative to what 

you are doing. 

 

As well as offering help, the Office Assistant also offers tips on quick or short cuts for the 

features you are using. If the Office Assistant is visible a light bulb appears next to the 

paper clip. Otherwise a light bulb appears on the tool on the toolbar. 
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MS Project - The Screen 
 

 

 

 

 
 

The Menus: 
Always displayed, some options depend on the selected view. 

Tool Bars: 
Buttons provide quick access to the most common commands, 

The bars can be customized 

Task Pane 
With options to help when ‘Getting Started’. Other task panes are 

available. 

Entry Bar: 
The entry point for text with outlining buttons. 

Status Bar: 
At the bottom of the screen showing the current status. 

Scroll Bars: 
When using a mouse to scroll the views and to move the boundary 

between two views. 

Working Area: 
The area for 1 or 2 views, the size of each can be adjusted. 
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Elements of the Default View 

The default Project view is the Gantt chart view, as displayed below. This view is used 

extensively in Microsoft Project. The Gantt chart consists of a Gantt table and a Gantt 

bar chart. The divider bar separates the two and can be repositioned to display more of 

the table or more of the chart. The Gantt table consists of rows and columns. Just like on 

a spreadsheet, the intersection of a row and a column is called a cell. The Gantt bar chart 

graphically displays your schedule on a time line. 

 
The status bar displays the current mode of operation and warning messages and 

indicates when special key control modes, such as Numb Lock mode, are on. The entry 

bar contains an Entry box where all information is input. The default toolbars are the 

Standard toolbar, Formatting toolbar and the Project Guide. Other toolbars can be 

displayed by choosing Toolbars from the View menu. 
 

 

 

Views and Tables 

 

A view is the format of the way that project data is displayed on the screen and there are 
a considerable number of different permutations that can be used. 

 
The View Menu is the first place where the view that is required is selected. The basic 
selection is between a Chart, a Form, or a Sheet. Some of the options in this menu can 

provide a split view to show two different displays for the same Task or Resource. 
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You can also use the View bar, located vertically on the left of the default view (if it is 

active). To activate/deactivate the View Bar, select View, View Bar. 

 

As well as the standard views achieved with the View menu or View bar, you can select 

More Views to see more detailed and complex views and forms. 
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The table below describes some of the main views in Project. 

 

Calendar: 
Shows the view in the form of a calendar. 

Gantt Chart: 
A diagrammatic view of the Tasks and their time scale. This 

chart can also show the relationship between Tasks and the 

Critical Path. It usually shows the task entry form alongside 

the Gantt chart. 

Network Diagram 
Chart: 

Network Diagram is an acronym for Programmed 

Evaluation Review Technique. This view represents each 

Task as a box with relevant information within it. The 

layout of the boxes on the chart and the lines that link the 

boxes represent the structure of the project. 

Task Usage: 
The Task Usage view displays project tasks with their 

assigned resources grouped underneath them. 

Tracking Gantt: 
The Tracking Gantt view displays two task bars, one on 

top of the other, for each task. The lower bar shows 

baseline start and finish dates, and the upper bar shows 

scheduled start and finish dates (or if the task has already 

started, meaning that the percentage complete is greater 

than zero, the upper bar shows the actual start and finish 
dates). 

Resource Graph: 
A graphical representation of a single resource and its 

utilization. 

Resource Sheet: 
A list of all the resources for the project. 

Resource Usage: 
This is a view that shows the use in hours per day for each 

resource. 

More Views: 
Allows the showing of combination views as well as 

details of a single Task 

Table:(Entry): 
Changes the form alongside the Gantt chart. 

Reports: 
Takes you into Report Wizard. 

Toolbars: 
Allows you to change the Toolbar display. 

View Bar: 
Activates the View bar, located vertically on the left of the 

screen. 

Zoom: 
Changes the amount of information you can see on screen, 

from days to years. 
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The Tracking Gantt View 

When you initially set up your project with tasks and dates, and then save the project with 

a baseline, the Tracking Gantt view displays those tasks as shown in the following 

example. 
 

 
 

The baseline bars and the scheduled or actual bars are synchronized. However, if the start 

date of task slips by, say, 2 days, the red scheduled bar will extend 2 days beyond the 

lower baseline bar. 

 
Because the tasks are linked, the slipping of task 2 will cause a ripple effect, making its 
successor tasks slip by 2 days as well. 

 
 

You can use the Tracking Gantt view to: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
The File Menu 

 See how tasks progress across time and evaluate the slippage of 
tasks. You can track progress by comparing baseline and scheduled 
or actual start and finish dates and by checking the completion 
percentage of each task. 

 View tasks graphically while still having access to detailed 
information about the tasks. 

 Create a project by entering tasks and the amount of time each task 
will take. 

 Establish sequential dependencies between tasks by linking them. 
When you link tasks, you can see how a change in the duration of 
one task affects the start and finish dates of other tasks and the 
project finish date. 

 Assign personnel and other resources to tasks. 

MS Project - Menus 

The File menu is typical of the windows environment. The command which pertains to 

MS Project is: 
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Properties: Provides basic information on the Project. 
 

The Edit Menu 

The Edit menu is also typical of the windows environment. Commands which pertain to 

MS Project include: 

 
Link Tasks: Create links between tasks. 
Unlink Tasks: Break an existing link. 

Go To: Go to a task or resource. (Depends on view.) 
 

The Insert Menu 

Among other things allows you to insert new rows for tasks or columns for information. 

You can also go to the Task information dialog box to add more detailed information to 

the current task. 
 

The Format Menu 

This changes dramatically when different views are selected. The following are the 
principal selections. 

 
 

For a Network Diagram the choices are: 

Text Styles: Modifies the size, and type of the selected text. 

Box Styles: Changes the appearance of the Network Diagram 

Boxes. 

Layout: Allows you to customize the way links are shown. 

Layout Now: Redraws to show changes made to links etc. 
 

For the Gantt chart the choices are: 

Font: Used to change the font. 

Bar: Change the selected Gantt Bar style 
Timescale: Allows you to set the displayed time at anything 

from years to minutes. 

Gridlines: Allows you to display or hide Gridlines and change 

Their appearance. 

Gantt chart Wizard: Takes you through the programs method of setting 

Up your Gantt chart. 

Text Styles: Change the font, size and colors 

Bar Styles: Change all Gantt bars. 

Details: Details of the Gantt chart 
Layout: Change the way the bars are displayed including 

links. 
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The Tools Menu 

The main choices here are Change Working Time, Tracking and Multiple Projects. 

Assign Resources: Apply various filters to the tasks. 
Level Resources: Shows resource levelling 

information 

Change Working Time: Format a new Calendar. 

Tracking: Check the progress. 

Links between Projects: Set up sub projects and links. 
 

The Project Menu 

This menu is for retrieving information on the project and its components. Some of the 

options launch sub menus. The commands are fairly self-explanatory and will become 

clearer later in this course. 

There are also the usual Window and Help options. 

 

You will find that the menu choices may change depending on the view selected. If this 

happens it simply means that the option you wanted is not available for that view. 

MS Project - The Tool Bars 

The Buttons provide quick access to some of the commands available from the pull down 

menus. The default arrangement of the toolbars is the Standard and Formatting bars 

active. 

 

The formatting bar is virtually identical to the same thing in other Office applications, 
except it has the Outline tools attached to it. These tools are for promoting and demoting 

tasks, Collapsing and expanding sub tasks plus the usual Text format and alignment 

buttons. 
 

 
 

The Standard toolbar contains the following buttons: 
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 Create a New blank file.

 

 Open an existing File.

 
 Save the current file

 

 Perform a File Search

 

 Print the active View

 
 Print Preview the active view

 

 Spell check the selection.

 
 Cut the highlighted section 

to the Clipboard

 
 Copy the highlighted section 

to the Clipboard

 

 Paste from the Clipboard.

 
 Format Painter.

 
 Undo the previous action.

 

 Insert a hyperlink Launch 

the Web toolbar.

 
 Link the selected tasks 

with a Finish-to-Start 

relationship

 Unlink the selected tasks. 

 

 Split the selected tasks 

 
 Open the Task 

Information dialog 
box. 

 
 Attach a note to the 

current task. 

 

 Add Resources. 

 
 Publish Information. 

 
 Group Information. 

 

 Zoom in. 

 
 Zoom out. 

 
 Got selected task. 

 
 Copy a static Picture so 

it can be used in another 

application. 

 

 Display the Office Assistant 

 

 

 

☞ Loading and Viewing a Project 

 Select File, Open to open any project file. 

 Press [Ctrl-Home] and [Alt-Home] to go to the start of the project. 

 Use the scroll tools to see the project progress. 

 Use the mouse to change the size of the various windows. 

 Alter the time scale with View, Zoom. 

☞ Change the View 

 Click on the View menu. 
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 Choose each of the top five and note the different screens. 

 Select View, Gantt chart to return to the original view. 

 Move the mouse to the central vertical bar on the screen when it will 
change to a double line with a double-headed arrow 

 Click and hold the left button and drag left to see more of the Gantt 

chart. 

 Repeat but drag right to see more of the Entry Table. 

☞ Change the Project Start Date 

 Select Project, Project Information from the menus. 

 Change the project Start Date. 
 

 
 Click Add and click OK and examine the views again. 

 Select Tools, Tracking, and Update Project to see project progress 
so far. 

 

 

☞ Exit Project 

 Select File, Close to close the existing project file. 
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Task Entry and Linking 

 

Entering Tasks 

 

This is the main activity in setting up a new project. The tasks which have been 

identified at the Design Stage must be entered. 

 

The system will hold task information in a task database, which we cannot access directly 

but is used by the system whenever we view task data. This is one of two databases the 

system uses the other being the resource database. 

 

It is important to understand that the system checks the data that it holds and where the 

data does not cross check then the system will generally update the database to make it 

right. It is important to keep an eye on this process; this will be discussed in a later 

section. 

 
As each entry is made the system will update the appropriate data and views to reflect the 

entries. 

 

The order of entry should be in the logical progression but this is not essential as it can be 
changed. 
Normal Task entry will be by using the standard Task Sheet. The Gantt View shows the 

Gantt chart in the right part of the window with the Task Sheet in the left part. 
 

The Task Information box/Task Sheet 
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The Task sheet is a view of the selected task with information shown in the columns as 

follows: - 

 

ID: 
The Task Identification number. 

Name: 
The Name of the Task. 

Duration: 
The time the Task will take including the time units. 

Start Date: 
This is the current Scheduled Start date for the Task. 

Not the Planned or Actual Start. 

Finish Date: 
The Scheduled Finish date. 

Predecessors: 
The ID numbers for the preceding Tasks that are linked 

to this Task. 

Resources: 
The names of the resources performing or used in the 

Task. 

 

 
 

The Task Entry Form 

It is possible to select the Task Entry view to see the Gantt chart in the upper pane and the 

Task Form in the lower pane. To do this choose View, More Views, and Task Entry. From 

the Task Sheet the following entries can be made. 

 
ID: The Task Identification number. 

Task Name: The Name of the Task. 
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Duration: The time the Task will take including the time units. 

As the entries are made, the Gantt chart will automatically be updated to display the 

tasks. 

 
 

If using the Task Form it will be possible to enter and/or view the following. 

Name: The name of the task 

Duration: The length of time the task will take and the units of time. 

Fixed: A check box to specify the start date to be fixed. 

Start: The scheduled start date, if this is not entered the system will calculate it 

from the data entered and the relationships defined. 

 

Finish: The scheduled finish date, entered or calculated as above. 

 

% Complete: A measure of the completion of the Task if it has been started. 
 

Tables and descriptions 
 

Resource Table 
 

ID: The identification number of the Resource 
Resource Name: The name of the resource. 

Units The number of units available for the resource. 

Work The amount of work currently assigned to the resource. 
 

Predecessor Table 

ID The identification number of the Predecessor. 

Predecessor Name: The name of the Predecessor. If this is not entered the system will 

look it up using the ID number. 

Type: The relationship with the current Task which will be FS, or SS, 

or FF. 

Lag The time delay between the ends of the Predecessor the start 

of the Successor. 
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It is not necessary to complete all the fields at entry time, as more information is added so 

the system will update the boxes. It is only necessary to enter the data that has been 

determined in the design stage. 

 
To enter task descriptions and duration’s one cell at a time: 

 

 In the Task Name column, select the first available cell and type the 
name of the task. 

 Press TAB 

 In the Duration column, type the value of the duration. If the 

duration is anything other than days, type m for minutes, h for hours, 
or w for weeks. 

 Press ENTER 

 Press LEFT ARROW to return to the Task Name column and repeat 

steps 1 through 4 as required. 
 

To enter task descriptions and durations by 
selecting a range: 

 
 Select the first cell (the numbered cell) of the desired range. 

 Drag the mouse through the range of cells you want to include. 

 In the first cell, type the desired information. 

 Press TAB 

 In the Duration column, type the appropriate information. 

 Repeat steps 4 and 5 as required. 

 

Note: Pressing SHIFT+TAB moves to the previous cell without deselecting the range. 
Clicking your mouse inside or outside the range will deselect the range. 
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Other Methods of Adding Tasks 

As a general rule Tasks can be added in any view where the tasks are displayed. The 

most obvious methods in addition to using the normal Task Entry view are as follows: - 
 

In the Gantt Chart or the Task Sheet 

An additional task can be added at the end of the list using the Insert, New Task 

command. 
Where additional information is required to be entered then this can be done by using the 

Task Information form which is opened by simply double-clicking a task in the task list. 

 
 

Using the Task Information Form 

It is possible to enter additional tasks using this form but it does not have all the possible 

entry points. The details of this form are included in the description of the Task Entry 

View above. 
 

Using the Network Diagram Chart 

Additional tasks can be placed within the chart by drawing a box and then entering the 

information within the fields. The relationship can be also be entered graphically by 

pointing to the Predecessor and dragging a line to the Successor. 

 

Where a relationship needs to be removed, a double click on it will display a box which 
has a delete button in it. 

 

Further time will be spent on this view later. 

 

Note: When you try to make a link that is not logical or possible, Project will warn 

you about this (see illustration below). 
 

Add Tasks 
The following tasks can be used as a practical in MS Project. 

 

[This column is for your 
info only] 

Task Duration 

Milestone task Course Development 0d 

Summary task Preparation 1d 

 

Sub tasks Install Software 2h 
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Studies and Specifications 1d 

Summary task Section Development  

Sub tasks Section 1  
 

 
Section 2  

 

 
Section 3  

 

 
Section 4  

 

 
Section 5  

 

 
Section 6  

 

 
Section 7  

 

 
Section 8  

 
 

 Enter the tasks as above. As you enter them Project will enter 1d as 
the default duration. Change this for Install Software. 

 

Note: By simply setting the Course Development task to zero days. It is given 

Milestone status. 

Linking Tasks 

In order that the system is able to display the overall time aspects of the project, each 

Task must be defined in terms of the Tasks on which it is dependent and in turn those 

Tasks that are dependent on it. It is also possible to define in what way these 

dependencies exist. 

Most associated Tasks will have a straightforward linear relationship. That is, the 

preceding task must finish before the next task can start. This is the Finish to Start 

relationship. 

 

This is not true for all situations, for example if bricks are being made to build a house, 

the building cannot start until some bricks are available but it is not necessary for all the 

bricks to be made before the building can start. The relationship between making the 

bricks and building the house can be described as Start to Start but with a time lag to 

allow for the first batch of bricks to be ready. 

 
An alternative relationship can be Finish to Finish which is true where two tasks must be 

ready at the same time. For example in the preparation of a banquet, the elements of each 

course must be completed at the same time in order that they are at their best. 

To summarize the main three relationships that can happen are as follows: - 

 

 Finish to Start (FS) 
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 Start to Start (SS) 

 Finish to Finish (FF) 

We can also fine tune these relationships by specifying Lag or Lead times as required. 
 

Linking of Tasks can be achieved by making the appropriate entry in any of the task 

views or highlighting the tasks and using the link button on the Tool Bar, or by using the 

Edit, Link Tasks command 
 

Note: You need to highlight the tasks you want to link before trying to link them. Use 

the mouse while holding down the [Ctrl] and/or [Shift] button(s) to do this 

☞ Links are most clearly shown in the Network Diagram 

 Enter some of the links by completing the Predecessor ID in the 
lower pane. 

 Add some of the links by selecting them and using the linking 

button. 
 

Defining the Summary Tasks 

Microsoft Project provides the ability to structure the tasks by setting different levels of 

tasks and grouping tasks under a summary task. This can be useful where the project has 

a considerable number of tasks; management can be made easier by only viewing and 

reporting on the summary tasks. 
 

 
 

There are five buttons on the far left of the Formatting Toolbar which can be used on a 
single task or group of highlighted tasks. 

 

 Promote the selection to the next higher level 

 Demote the selection to the next lower level 

 Expands a summary task to show its subordinate tasks 

 Collapse a summary task to hide the subordinate tasks 

 Hide assignments 

 Show all subtasks, or those of a particular outline level. 
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☞ Create Summary Tasks and Link Tasks 

 Select the sub tasks Install Software and Studies and Specification. 

 Indent the tasks to make them sub tasks. 

 While they are still selected link them (chain button or Edit menu). 

 Make Sections 1 to 8 sub tasks and link them. 
 

 
☞ Insert Tasks 

If you miss a task from your list you can insert a blank line and type the information. 

 

 Click on Studies and Specifications. 

 Right-click and choose New Task to insert a blank row. 

 Type Backup Installation as the task and set the time to 1h. 

☞ Add New Tasks 

Having added tasks you can continue adding tasks at the end of your project. 
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 Move to the line below Section 8 and type Slide Development. 

 Set the Duration to 5d. 

 Out went the task by clicking on the Outwent button. 

 Link it to Section 8. 

 Save your project as Training Course. 

 Save with a baseline. 

☞ Change Duration 

The default duration is 1day. To change this you can simply overtype with the new value. 

 

 Change the durations for 
each Module to 2d. 

 When the Wizard appears 

READ THE 

INFORMATION then 

Click on the OK button. 
 

 Select all the remaining 
tasks. 

 Open the Task information box. 

 Set the duration to 1.5d 

☞ Multiple Links 

Tasks can be linked to more than one predecessor. 

 

 Select the task Slide Development, hold down the Ctrl key and 
select the task Module 1. 

 Click on the Link Tasks button. 

 When you get a warning, try to figure out why the link is illogical. 
Look at the Gantt chart if it makes it easier to think. 
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Save a Baseline 

 Select Tools, Tracking, and Save Baseline from the menus. 

 Click on the Save baseline radio button. 

 Click on the OK button. 
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CHAPTER 6 

CONCLUSION 

This section concludes this study by answering the stated research questions 

based on the findings. Further, the theoretical and empirical contribution is 

presented followed by the limitations of the study as well as suggestions for 

further research. 

Meeting the performance objectives: There are two ways in which the plan influences the 

specification of the project. Firstly, it will embody methods of working and procedures 

which influence performance and these may have to be revised in order to effect a reduction 

in the project duration. It may be necessary to find alternative ways of doing things which 

are less satisfactory and the implications of these decisions must be carefully evaluated in 

relation to the project as a whole and the possible effect on the specification. 

The second aspect, already mentioned, is the relationship between performance and 
time for certain activities. Any reduction in the time allowed for development work and 

testing may affect ultimate performance and the plan must be checked to establish whether 

the original specification can still be met. In this way the network can give some indication 

of the relationship between time and performance, allowing the decisions to be made which 

are consistent with overall project objectives. 

 

The final network: There are usually a number of ways in which the plan can be revised to 
meet project objectives and each will have different implications. The use of network to 

simulate these alternatives can help in finding the right balance between the objectives. 

Many changes will be made to the initial network before a final plan can be agreed upon 

and on the basis of the final plan detailed work schedules are worked out. 
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